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THANK YOU FOR CHOOSING ROSS VIDEO
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support
2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:
1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 

times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)

About this Guide
• Ross Part Number: 7800DR-003-12.5
• Release Date: July 10, 2025. Printed in Canada.
• Software Issue: 12.5

The information contained in this Guide is subject to change without notice or obligation.



Copyright
© 2014 - 2025 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross 
Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and 
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior 
written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross 
Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting 
from the use of the information contained herein.

Patents
Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886; 
7,914,332; 8307284, 2039277; 1237518; 1127289 and other patents pending.

Warranty and Repair Policy
Ross Video Limited (Ross) warrants its Streamline Pro Server systems to be free from defects under normal use and 
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty
For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your Streamline Pro 
Server system, contact your regional sales manager.



Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration. You can also contact Ross Video for more information on the environmental performances of 
our products.

Use of Hazardous Substances in Electrical and Electronic 
Products (China RoHS)
Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html


Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613.652.4886
Fax: (+1) 613.652.4425

Technical Support: (+1) 613.652.4886
After Hours Emergency: (+1) 613.349.0006

Email (Technical Support): techsupport@rossvideo.com
Email (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
A Word of Thanks
Thank you for choosing Streamline Pro as your Ross Video media asset management solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Streamline Pro media asset management solution from Ross Video. We are 
confident of your future pleasure with your choice.

Yours Sincerely,

Peter Abecassis
Director of Product Management - Production Workflow
peter.abecassis@rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide
This guide contains the following chapters that cover the installation and configuration of Streamline Pro software:

• Chapter 1, “Introduction” summarizes the guide and provides important terms, conventions and feature 
descriptions.

• Chapter 2, “System Requirements” provides the recommended minimum hardware and software requirements 
to ensure that the Streamline Pro software functions correctly.

• Chapter 3, “Software Upgrades” provides instructions on how to upgrade the Streamline Pro software.
• Chapter 4, “Software Installation” provides instructions on how to install the Streamline Pro software on a 

computer after a system re-image.
• Chapter 5, “Software Licensing” provides instructions for licensing Streamline Pro software.
• Chapter 6, “System Configuration” provides instructions on how to configure Streamline Pro software options.

If you have questions pertaining to the operation of the Ross Video product, please contact us at the numbers listed 
in the section “Contacting Technical Support” on page 1–3. Our technical staff is always available for 
consultation, training, or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Work Order Manager panel, click Create New Work Order.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Creating a Work Order” in the Streamline Pro User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

When the Streamline Pro Client cannot connect to the network, a Message dialog box opens to report the 
connection problem.
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Getting Help
The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the 
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help 
topics and User Guide:

• Contents — table of contents
• Index — keyword reference
• Search — full text search
• Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files on the Ross Video product Software 
Installation DVD.

Contacting Technical Support
Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

Our telephone number is: +44 (0)1189502446

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.
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Online

E-mail: techsupport@rossvideo.com 

Website: open a support request using the link http://www.rossvideo.com/support/tech-support.html to open a 
support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com/support/tech-support.html
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System Requirements
Ross Video based Streamline Pro products on mainstream PC hardware that use the Microsoft® Windows® 
operating system. To ensure that the Streamline Pro functions correctly, verify that the computer selected to run 
Streamline Pro software meets the recommended requirements described in the following sections:

• Hardware
• Software
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Hardware
Ross Video recommends the following minimum computer hardware configuration to run Streamline Pro software:

• CPU — quad-core Intel® Xeon® E3 with Hyper-Threading
• RAM — 32GB
• Hard Drive — Minimum 100 GB free
• LAN — 100 MB/s

Software
Ross Video recommends the following minimum computer software configuration to run Streamline Pro software:

• Microsoft® Windows® Server 2019 64-bit English only with latest patches, or
Microsoft® Windows® Server 2016 64-bit English only with latest patches, or
Microsoft® Windows® Server 2012 R2 64-bit English only with latest patches

Streamline Pro can be accessed using one of the following web browsers:

• Microsoft Internet Explorer® version 11 or greater
• Google Chrome™ version 51 or greater
• Mozilla Firefox® version 52 or greater
• Apple Safari® version 10.2 or greater
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Software Upgrades
This chapter provides instructions for upgrading the Streamline Pro software on your computer to the latest version 
of the Streamline Pro software.

The following topics are discussed in this chapter:

• Before a Software Upgrade
• Upgrade to the Latest Streamline Pro Software
• Setting a Custom Password for the Database Superuser
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Before a Software Upgrade
Before you start an upgrade of the Streamline Pro software on your Streamline Pro Server, perform the following 
tasks:

• Have a qualified Ross Video technician perform any required maintenance or repairs on the Streamline Pro 
Server.

• Use Add/Remove Programs control panel to remove any existing version of Streamline Pro software.
• Exit all other Windows® programs currently running on the Streamline Pro Server.
• Temporarily disable anti-virus software running on the Streamline Pro computer. Some heuristic-based intrusion 

detection systems prevent the upgrade of Streamline Pro software. Re-enable anti-virus software after upgrading 
the Streamline Pro software.

Contact a Ross Video sales representative about Streamline Pro commissioning, training, and update services.

 After upgrading Streamline Pro software, you must obtain feature licenses from Ross Video Technical Support 
before users can access Streamline Pro features.

For More Information on...
• Ross Video Technical Support phone numbers, refer to the section “Contacting Technical Support” on 

page 1–3.

Upgrade to the Latest Streamline Pro Software
This section provides instructions for upgrading Streamline Pro software versions

When upgrading Streamline Pro software, do not uninstall the Streamline Pro Database. Streamline Pro software 
upgrade procedures only require the uninstall of the previous version of Streamline Pro software.

 Performance tuned Streamline Pro settings must be re-tuned after a Streamline Pro software upgrade.

To upgrade Streamline Pro software

1. Use Add/Remove Programs on the Control Panel of your computer to remove the Streamline Pro software 
installed on the Streamline Pro computer.

2. Restart the Streamline Pro computer.

3. After the Streamline Pro computer restart, log in to the Streamline Pro computer and run the Ross Streamline 
Pro Setup wizard (Streamline Pro-12.5.x-xxx-xxx.msi) on the Streamline Pro Software DVD. For 
the complete installation procedure, refer to the chapter “Software Installation” on page 4–1.

4. After the Streamline Pro computer restarts, log in to the Streamline Pro computer and continue with one of the 
following:

• If your Streamline Pro Database uses the standard password of postgres for the database superuser 
postgres, continue with step 5 in this procedure.

• If your Streamline Pro Database does not use the standard password of postgres for the database superuser 
postgres, complete the procedure in the section “Setting a Custom Password for the Database 
Superuser” on page 3–3.
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5. Use one of the following methods to open the Streamline Pro web page:

• On the Desktop, double-click the Ross Streamline Pro icon.
• Use the Start menu to select All Programs > Ross Streamline Pro > Ross Streamline Pro.

The Upgrade Required web page opens in a web browser window. If the Upgrade Required web page does 
not open, contact Ross Video Technical Support.

6. Click Start Upgrade.

After the upgrade completes, the Streamline Pro Login screen opens. If the Streamline Pro Login screen does 
not display, contact Ross Video Technical Support.

7. Retune the Streamline Pro settings by completing the procedure “To tune Streamline Pro settings in the 
jvm.conf file” on page 4–11.

Setting a Custom Password for the Database Superuser
During the installation of the PostgreSQL database, you must set the password for the database superuser and 
service account named postgres. If the password set for postgres is not the standard password of postgres, 
the installer must configure the Streamline Pro software to use the custom postgres password.

To set a custom postgres password

1. Use one of the following methods to open the Streamline Pro web page:

• On the Desktop, double-click the Ross Streamline Pro icon.
• Use the Start menu to select All Programs > Ross Streamline Pro > Ross Streamline Pro.

The Streamline Pro Login screen opens. If the Streamline Pro Login screen does not open, contact Ross 
Video Technical Support.

2. At the Streamline Pro Login screen, enter the following user name and password in the provided boxes:

• Username — maintenance
• Password — maintenance

3. Click Login.

You are logged into the Streamline Pro.
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4. In the Tools section of the Streamline Pro toolbar, click the  Configuration icon.

The Database tab of the Configuration panel opens.

5. In the Password box, enter the custom password set for the database superuser named postgres.

6. Click OK.

An Alert dialog box opens.

7. In the Alert dialog box, click OK.

The Alert and Configuration dialog boxes close.

8. On the Streamline Pro toolbar, click the Logout icon.

A Message dialog box opens.

9. In the Message dialog box, click OK to log out of Streamline Pro.

10. Close the web browser.

11. From the Windows® Desktop, press Windows Key+R.

The Run dialog box opens.

12. In the Open box, type the following application name: services.msc

13. Click OK.

The Services window opens.

14. In the Services list, locate and select the Ross Streamline Pro service.

15. Click Restart for the Ross Streamline Pro service.
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16. Use the File menu to select Exit.

The Service dialog box closes.

17. Use one of the following methods to open the Streamline Pro web page:

• On the Desktop, double-click the Ross Streamline Pro icon.
• Use the Start menu to select All Programs > Ross Streamline Pro > Ross Streamline Pro.

The Upgrade Required web page opens in a web browser window.

 If the Upgrade Required web page does not open, contact Ross Video Technical Support.

18. Click Start Upgrade.

After the upgrade completes, an Alert dialog opens with the Streamline Pro Login screen. If the Streamline 
Pro Login screen does not open, contact Ross Video Technical Support.

19. Retune Streamline Pro settings by completing the procedure “To tune Streamline Pro settings in the 
jvm.conf file” on page 4–11.
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Software Installation
This chapter provides instructions for installing Streamline Pro software on a Streamline Pro computer after a 
system re-image.

The following topics are discussed in this chapter:

• Before a Software Install
• Installing Streamline Pro Database Software
• Installing Streamline Pro Software
• Setting a Custom Password for the Database Superuser
• Tuning the Streamline Pro and Database for Performance
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Before a Software Install
Before you install Streamline Pro software on a Streamline Pro computer, perform the following tasks:

• Have a qualified Ross Video technician perform any required maintenance or repairs on the Streamline Pro 
computer.

• Exit all other Windows® programs currently running on the Streamline Pro computer.
• Temporarily disable anti-virus software running on the Streamline Pro computer. Some heuristic-based intrusion 

detection systems prevent the installation of Streamline Pro software. Re-enable anti-virus software after 
installing the Streamline Pro software.

Contact a Ross Video sales representative for information about Streamline Pro commissioning, training, and 
update services.

 After installing Streamline Pro software, you must obtain Streamline Pro feature licenses from Ross Video 
Technical Support before users can access Streamline Pro features.

 Order of Operations for the Streamline ecosystem of products: Streamline Xchange must be installed before 
opening the Streamline Pro web client.

For More Information on...
• Ross Video Technical Support phone numbers, refer to the section “Contacting Technical Support” on 

page 1–3.

Installing Streamline Pro Database Software
Streamline Pro uses the PostgreSQL database to store and manage application data. Only the initial installation or 
recover installations of Streamline Pro software on a computer require the installation of the PostgreSQL database 
software.

 You must install and configure PostgreSQL database software on the Streamline Pro computer before installing 
Streamline Pro on the computer.

Upgrading Streamline Pro software to a new version does not require a re-installation of the PostgreSQL database 
software. For the complete upgrade procedure, refer to the chapter “Software Upgrades” on page 3–1.

To install PostgreSQL database software for an initial install of Streamline Pro software

1. On the Streamline Pro computer, exit all currently running Windows® applications.

2. Insert the Streamline Pro software DVD into the DVD-ROM drive.

3. On the Desktop, open My Computer.

4. In the My Computer explorer window, open the DVD-ROM Drive.

5. Right-click the postgresql-9.3.5-3-windows-x64.exe icon and select Run as administrator from the Shortcut 
menu.
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The Setup wizard opens.

6. Click Next.

The Installation Directory dialog opens.

7. Click Next.

The Data Directory dialog box opens.

8. Replace the folder name in the Data Directory box with the following folder name:

C:\ProgramData\PostgreSQL\9.3\data 

9. Click Next.

The Password dialog box opens.
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10. In the Password box, type the following password for the data base super user named postgres:

postgres 

If the password of postgres does not meet the password security requirements set by your organization, enter 
a different password that meets the requirements. Remember to replace the password postgres with your 
password when installing, re-installing, or upgrading the Streamline Pro software.

11. In the Retype Password box, type the password you set in step 10.

12. Click Next.

The Port dialog box opens.

13. Click Next.

The Advanced Options dialog box opens.

14. Use the Locale list to select [Default locale].

The [Default locale] option sets the PostgreSQL database local to the same locale set for the Windows 
operating system.

15. Click Next.

The Ready to Install dialog box opens.



Streamline Pro Streamline Pro User Guide (v12.5) Software Installation • 4–5

16. Click Next.

The Installing panel opens. A progress bar displays the installation status. After the installer finishes installing 
the required files, the Completing the PostgreSQL Setup Wizard dialog box opens.

17. Clear the Stack Builder check box.

Click Finish.

18. The Setup wizard closes.

To configure the data base for Streamline Pro

1. From the Windows Desktop, use the Start menu to select All Programs > PostgreSQL 9.0 > pgAdminIII.

The pgAdminIII window opens.

2. In the Object Browser tree view, right-click the PostgreSQL 9.3 (localhost:5432) database and select 
Connect from the shortcut menu.

The Connect to Server dialog box opens.

3. In the Password box, type the following password:

postgres

If the password of postgres does not meet the password security requirements set by your organization, enter 
the custom password set during installation of the Streamline Pro software on the Streamline Pro computer.
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4. Click OK.

The PostgreSQL 9.0 node expands in the Object Browser tree view.

5. In the expanded PostgreSQL 9.0 node, right-click the Databases node and select New Database from the 
shortcut menu.

The New Database dialog box opens.

6. In the Name box, type the following name:

streamline

7. Click OK.

PostgreSQL adds the Streamline Pro database to the Properties tab of the pgAdmin III window.

8. In the pgAdmin III window, use the File menu to select Exit.

The pgAdmin III window closes.

Streamline Pro Service User
You must also set the user that runs the PostgreSQL database service before you install Streamline Pro software.

To set the user that runs the PostgreSQL database service

1. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.

2. In the Open box, type the following application name:

services.msc 
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3. Click OK.

The Services window opens.

4. In the Services list, locate the postgresql-x64-9.3 service.

5. Right-click the postgresql-x64-9.3 service and select Properties from the shortcut menu.

The postgresql-x64-9.3 Properties dialog box opens.

6. Click the Log On tab.

The Log On tab opens.

7. Select the Local System Account option.

8. Click OK.

The Services alert dialog box opens.

9. In the Services alert, click OK.

The Services alert and the postgresql-x64-9.3 Properties dialog box close.

10. In the Services window, click Restart for the postgresql-x64-9.3 service.

11. Use the File menu to select Exit.

The Services window closes.
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Installing Streamline Pro Software
After installing and configuring the PostgreSQL database software on the Streamline Pro computer, you can install 
the Streamline Pro software.

 After installing Streamline Pro software, you must obtain Streamline Pro feature licenses from Ross Video 
Technical Support before users can access Streamline Pro features.

To install Streamline Pro software

1. On the Streamline Pro computer, exit all currently running applications.

2. Temporarily disable anti-virus software running on the Streamline Pro computer.

Some heuristic-based intrusion detection systems prevent the installation of Streamline Pro software.

3. Insert the Streamline Pro software DVD into the DVD-ROM drive.

4. On the Desktop, open My Computer.

5. In the My Computer explorer window, open the DVD-ROM Drive.

6. Double-click Streamline Pro-12.5.x-xxxx-xxxx.msi.

If a Security Warning displays, click Run.

The Ross Streamline Pro Setup wizard opens.

7. Click Next.

The End-User License Agreement screen opens.

8. Read the Streamline Pro Software License Grant.

9. Select the I accept the terms of the license agreement option.

10. Click Next.

The Choose Setup Type screen opens.
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11. Click the Ross Streamline Pro icon.

The Ready to Install screen opens.

12. Click Install.

After installation of the Streamline Pro is complete, the Installation Complete screen opens.

13. Click Finish.

The Ross Streamline Pro Setup wizard closes and adds the following icons to the Desktop:

• Streamline Pro Readme 
• Streamline Pro Release Notes 
• Ross Streamline Pro 

The Streamline Pro starts automatically after the installation of the Streamline Pro software.

14. Re-enable anti-virus software.

15. Continue with one of the following:

• If your Streamline Pro database uses the standard password of postgres for the database superuser 
postgres, do the following:
› Performance tune the Streamline Pro and database by completing the procedure in the section “Tuning 

the Streamline Pro and Database for Performance” on page 4–11.
› License the Streamline Pro software by completing the procedures in the chapter “Software Licensing” 

on page 5–1.
• If your Streamline Pro database does not use the standard password of postgres for the database superuser 

postgres, complete the procedure in the section “Setting a Custom Password for the Database 
Superuser” on page 4–9.

Setting a Custom Password for the Database Superuser
During the installation of the PostgreSQL database, you must set the password for the database superuser and 
service account named postgres. If the password set for postgres is not the standard password of postgres, 
the installer must configure the Streamline Pro software to use the custom postgres password.
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To set a custom postgres password

1. Use one of the following methods to open the Streamline Pro web page:

• On the Desktop, double-click the Ross Streamline Pro icon.
• Use the Start menu to select All Programs > Ross Streamline Pro > Ross Streamline Pro.

The Streamline Pro Login screen opens. If the Streamline Pro Login screen does not open, please contact 
Ross Video Technical Support.

2. At the Streamline Pro Login screen, enter the following user name and password in the provided boxes:

• Username — maintenance 
• Password — maintenance 

3. Click Login.

You are logged into the Streamline Pro.

4. In the Streamline Pro toolbar, click the  Configuration icon.

The Database tab of the Configuration panel opens.

5. In the Password box, enter the custom password set for the database superuser named postgres.

6. Click OK.

An Alert dialog box opens.

7. In the Alert dialog box, click OK.

The Alert and Configuration dialog boxes close.

8. On the Streamline Pro toolbar, click the Logout icon.

A Message dialog box opens.

9. In the Message dialog box, click OK to log out of Streamline Pro.

10. Close the web browser.

11. From the Windows Desktop, press Windows Key+R.

The Run dialog box opens.
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12. In the Open box, type the following application name:

services.msc 

13. Click OK.

The Services window opens.

14. In the Services list, locate and select the Ross Streamline Pro service.

15. Click Restart for the Ross Streamline Pro service.

16. Use the File menu to select Exit.

The Services dialog box opens.

17. Performance tune the Streamline Pro and database by completing the procedure in the section “Tuning the 
Streamline Pro and Database for Performance” on page 4–11.

18. License the Streamline Pro software by completing the procedures in the chapter “Software Licensing” on 
page 5–1.

Tuning the Streamline Pro and Database for Performance
The goal of the Streamline Pro and database performance tuning is to maximize use of system resources to perform 
work as efficiently and rapidly as possible. The installation or upgrade of Streamline Pro software configures the 
Streamline Pro and the Streamline Pro database to manage work effectively, but it is possible to greatly improve 
performance by tuning the values of a few key Streamline Pro and database settings.

Streamline Pro Settings
The Streamline Pro saves configuration settings in the jvm.conf file. The settings to tune are as follows:

• wrapper.java.initmemory — sets the initial Java heap size for the Streamline Pro.
• wrapper.java.maxmemory — sets the maximum Java heap size for the Streamline Pro.

 You must retune Streamline Pro settings after each install or upgrade of Streamline Pro software.

To tune Streamline Pro settings in the jvm.conf file

1. On the Streamline Pro computer, locate the jvm.conf file in the following folder:

C:\Program Files\Ross Video\Streamline Pro\configuration 

2. Use a text editor to open and edit the jvm.conf file.

3. In the jvm.conf file, locate the following setting:

wrapper.java.initmemory 
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4. Replace the default memory value for the wrapper.java.initmemory setting with a tuned value. The tuned 
value depends on the amount of RAM installed in the Streamline Pro system. Use the following table to set the 
wrapper.java.initmemory value for your Streamline Pro system:

5. Locate the following setting:

wrapper.java.maxmemory 

6. Replace the default memory value for the wrapper.java.maxmemory setting with a tuned value. The tuned 
value depends on the amount of RAM installed in the Streamline Pro system. Use the following table to set the 
wrapper.java.initmemory value for your Streamline Pro system: 

7. Save the updated jvm.conf file and exit the text editor.

8. Re-start the Streamline Pro service as follows:

a. From the Windows Desktop, press Windows Key+R.

b. In the Open box, type services.msc.

c. Click OK.

d. In the Services list, locate and select the Ross Streamline Pro service.

e. Click Restart for the Ross Streamline Pro service.

f. Use the File menu to select Exit.

9. Follow the procedure in the section “Database Settings” on page 4–12 to tune the Streamline Pro database.

Database Settings
PostgreSQL saves configuration settings in the postgresql.conf file. The settings to tune are as follows:

• max_connections — sets the maximum number of concurrent connections to the database server.
• work_mem — sets the amount of memory that the internal sort operations table and hash table use before 

switching to temporary disk files.
• shared_buffers — sets the amount of memory dedicated to PostgreSQL to use for caching data.
• effective_cache_size — sets the amount of memory available for disk caching by the operating system and 

within the database itself.

System RAM
2 GB 4 GB 8 GB 12 GB 16 GB 32 GB
256 512 1024 1536 2048 4096

System RAM
2 GB 4 GB 8 GB 12 GB 16 GB 32 GB
512 1024 2048 3072 4096 8192
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To tune database settings in the postgresql.conf file

1. If the Streamline Pro database is not running on the same computer as the Streamline Pro, log in to the 
Streamline Pro database computer.

2. Stop the Streamline Pro service as follows:

a. From the Windows Desktop, press Windows Key+R.

b. In the Open box, type services.msc.

c. Click OK.

d. In the Services list, locate and select the Ross Streamline Pro service.

e. Click Stop for the Ross Streamline Pro service.

3. Locate the postgresql.conf file stored in the PostgreSQL data folder.

By default, the following folder contains the postgresql.conf file:

D:\Program Files\PostgreSQL\9.0\data 

If you changed the Data Directory folder during the PostgreSQL database software install, look for the 
postgresql.conf file in the specified Data Directory folder.

4. Use a text editor to open and edit the postgresql.conf file.

5. In the postgresql.conf file, locate the following setting:

max_connections 

6. Replace the default connections value for the max_connections setting with the following tuned value:

max_connections = 200 

7. Locate the following line of text:

work_mem 

8. If a # character precedes the work_mem setting, delete the # character.

9. Replace the default memory value for the work_mem setting with a tuned value. The tuned value depends on 
the type of Streamline Pro system and the amount of RAM installed in the system. Use the following table to 
set the work_mem value for your Streamline Pro system:

10. Locate the following line of text:

shared_buffers 

11. If a # character precedes the shared_buffers setting, delete the # character.

12. Replace the default size value for the shared_buffers setting with the following tuned value:

shared_buffers = 512MB 

13. In the postgresql.conf file, locate the following line of text:

effective_cache_size 

14. If a # character precedes the effective_cache_size setting, delete the # character.

System RAM
2 GB 4 GB 8 GB 16 GB 32 GB

Streamline Pro and Database 
Server

4 MB 8 MB 16 MB 24 MB 32 MB

Dedicated Database Server 8 MB 16 MB 32 MB 48 MB 64 MB
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15. Replace the default memory value for the effective_cache_size setting with a tuned value. The tuned value 
depends on the type of Streamline Pro system and the amount of RAM installed in the system. Use the 
following table to set the effective_cache_size value for your Streamline Pro system:

16. Save the updated postgresql.conf file and exit the text editor.

17. Restart the PostgreSQL service as follows:

a. In the Services list of the Services window, locate and select the postgresql-x64-9.0 service.

b. Click Restart for the postgresql-x64-9.0 service.

18. Restart the Streamline Pro service as follows:

a. In the Services list of the Services window, locate and select the Ross Streamline Pro service.

b. Click Restart for the Ross Streamline Pro service.

19. In the Services window, use the File menu to select Exit.

System RAM
2 GB 4 GB 8 GB 16 GB 32 GB

Streamline Pro and Database 
Server

800 MB 1600 MB 3200 MB 4800 MB 6400 MB

Dedicated Database Server 1200 MB 2400 MB 4800 MB 7200 MB 9600 MB
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Software Licensing
Ross Video uses a product key and feature license keys to control user access to Streamline Pro features. You can 
obtain a Streamline Pro product key from Ross Video Technical Support. This chapter provides instructions for 
licensing a Streamline Pro.

When a Streamline Pro computer has multiple active network adapters (wireless, wired, or multiple NIC cards), 
disabling an adapter after licensing the Streamline Pro may invalidate your Streamline Pro product key. To 
re-license your Streamline Pro, restart the server and reactivate the product key.

The following topics are discussed in this chapter:

• Activating a Product Key for Streamline Pro Software
• Reactivating a Product Key
• Deactivating a Product Key
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Activating a Product Key for Streamline Pro Software
Ross Video uses product keys to manage user licenses for Streamline Pro features. You can obtain a Streamline Pro 
product key from Ross Video Technical Support.

When you activate a Streamline Pro software product key, your Streamline Pro computer must contact the Ross 
Video Activation Server through the internet.

To activate a Streamline Pro product key

1. Verify that the Streamline Pro computer can connect to the Internet.

2. Use one of the following methods to open the Streamline Pro web page:

• On the Desktop, double-click the Ross Streamline Pro icon.
• Use the Start menu to select All Programs > Ross Streamline Pro > Ross Streamline Pro.

An Alert dialog box opens with the Ross Streamline Pro web page.

 If the Ross Streamline Pro web page does not open, contact Ross Video Technical Support.

3. In the Alert dialog box, click OK.

The Alert dialog box closes.

4. At the Streamline Pro Login screen, enter the following user name and password in the provided boxes:

• Username — root 
• Password — password 

5. Click Login.

You are logged into the Streamline Pro as an administrator.

 If a message displays indicating that the system is in maintenance mode, Streamline Pro cannot communicate 
with the database. Contact Ross Video Technical Support.

6. In the Tools section of the Streamline Pro toolbar, click the  Configuration icon.

The Configuration panel opens.

7. Click the Licensing tab.

The Licensing Configuration tab opens.
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8. Obtain a Streamline Pro product key from Ross Video Technical Support. 

9. In the Product Key box, enter the product key obtained from Ross Video Technical Support.

10. Click Activate.

After activating the entered product key, an Alert dialog box opens requesting a web browser window refresh.

11. Click OK

The Alert dialog box closes and the Licensing Configuration tab updates to display the new feature licenses 
associated with the activated product key. The Status column displays one of the following states:

12. Click OK.

The Configuration dialog box closes.

13. Refresh your web browser window.

Streamline Pro add icons to the toolbar for the newly activated features, making the features accessible to 
Streamline Pro users.

For More Information on...
• Ross Video Technical Support phone numbers, refer to the section “Contacting Technical Support” on 

page 1–3.

Reactivating a Product Key
After purchasing new features for a Streamline Pro system, the Streamline Pro product key requires a reactivation to 
make the purchased features available to Streamline Pro users.

To reactivate a Streamline Pro product key

1. Log in to Streamline as an administrator.

2. In the Tools section of the Streamline Pro toolbar, click the  Configuration icon.

The Configuration window opens.

3. On the Configuration window toolbar, click the  System icon.

The System panel opens.

4. Click the Licensing tab.

The Licensing Configuration tab opens.

5. Click the License Options link.

 The Product Key field displays the currently activate product key.

Background Status Description

 Green Active The feature is active and available to Streamline Pro users.

 Yellow Expires in # days The feature availability for Streamline Pro users expires in the 
displayed number of days.

 Red Expired The feature has expired and is no longer available to Streamline Pro 
users.

 Red Invalid MAC The feature license key is invalid for the active network interface 
card of the Streamline Pro computer.

 White Not Purchased The feature is not accessible to Streamline Pro users, but it is 
available for purchase.
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6. Click Reactivate.

After reactivating the product key, an Alert dialog box opens requesting a refresh of the web browser window.

7. Click OK.

The Alert dialog box closes, and the Licensing Configuration tab is updates to display with new feature 
licenses associated with the reactivated product key.

8. Click OK.

The Configuration dialog box closes.

9. Refresh your web browser window.

Streamline adds icons to the toolbar for the newly activated features, making the features accessible to 
Streamline users.

Deactivating a Product Key
When you want to move Streamline Pro software on another computer, you must find deactivate the Streamline Pro 
software on the current Streamline Pro computer.

To deactivate a Streamline Pro product key

1. Log in to Streamline as an administrator.

2. In the Tools section of the Streamline Pro toolbar, click the  Configuration icon.

The Configuration window opens.

3. On the Configuration window toolbar, click the  System icon.

The System panel opens.

4. Click the Licensing tab.

The Licensing Configuration tab opens.

5. Click the License Options link.

 The Product Key field displays the currently activate product key.

6. Click Deactivate.

After deactivating the product key, an Alert dialog box opens.

7. Click OK.

The Alert dialog box closes, and the product key shown in the Product Key box deactivates. You can use the 
deactivated product key to activate Streamline software on another computer.

Deactivating a product key unlicenses and removes Streamline user access to all the Streamline features 
associated with the product key.

8. Click OK.

The Configuration dialog box closes.
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System Configuration
The following topics are discussed in this chapter:

• Changing the Root User Password
• Accessing the Configuration Interface
• Changing the Streamline Pro Wallpaper



6–2 • System Configuration Streamline Pro Streamline Pro User Guide (v12.5)

Changing the Root User Password
For security reasons, we recommend you change the default root user password.

To change the root user password

1. Log in to Streamline Pro.

2. In the Tools section of the Streamline Pro toolbar, click the  Change Password icon.

The Change Password panel opens.

3. In the Old Password box, type the root user password:

password 

4. In the New Password box, type a new password that you can remember.

5. In the Verify Password box, type the new password again.

6. Click Change Password.

The login password for the root user changes to the newly set password.

Accessing the Configuration Interface
Use the Configuration interface to set up user accounts, user roles, and system properties. Refer to the Streamline 
Pro Configuration Guide for more details.

To access the Configuration interface

1. Log in to Streamline Pro.

2. In the Tools section of the Streamline Pro toolbar, click the  Configuration icon.

The Configuration panel opens.

Changing the Streamline Pro Wallpaper
You can set up the Streamline Pro wallpaper graphic to appear as your Streamline Pro desktop background image. 
The Streamline Pro wallpaper features the Streamline Pro logo, and clearly identifies the computer as a Streamline 
Pro.

To install Streamline Pro wallpaper

1. On the Streamline Pro computer, open either Microsoft® Internet Explorer® or Google® Chrome®, and then 
navigate to:

http://localhost/resources/Streamline Pro/images/wallpaper/1920x1080.jpg 

The wallpaper image opens in the web browser.

2. If you want to replace your current Desktop background image with the Streamline Pro wallpaper, do one of 
the following:

• In Internet Explorer — right-click the wallpaper graphic file and then click Set as background.
• In Chrome — right-click the wallpaper graphic and then click Save image as....Save the image to your 

Desktop. Navigate to the image, right-click it, and then click Set as Desktop background.
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Configuring Streamline Pro for 
Third-Party NRCS or NLE 
Systems
Streamline Pro enables you to use our plugin with supported third party software applications. Currently these 
include supported newsroom control systems (NRCS) and Non-Linear Editors (NLE). This chapter includes basic 
setup information for administrators and client side configuration.

 NOTE: Streamline Pro (NLE) Plugin features may vary from the Streamline Pro (NRCS) Plugin features. 

This chapter discusses the following topics:

• “Third Party Newsroom Control Systems (NRCS)”
• “Third Party Non-Linear Editors (NLE)”
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Third Party Newsroom Control Systems (NRCS)
Streamline Pro allows you to access multiple assets from within a single Inception News platform, or via a 
supported NRCS newsroom interface — such as AP ENPS. The supported NRCS systems are listed below. 

 PREREQUISITES: The procedures below assume that the required software for Streamline Pro is already 
installed and only details how to add the Streamline Pro Plugin to the third-party system. Please refer to the 
Streamline Pro Release Notes for supported versions, upgrade path information, and special notices not included 
in the manuals.

• “AP ENPS NRCS Setup”

AP ENPS NRCS Setup
AP ENPS newsroom supports the Streamline Pro MOS Plugin. An AP ENPS administrator must run through the 
steps below to add a new MOS device to the AP ENPS newsroom on the primary server, and then configure the 
Client workspace. This will allow users to access the Streamline Pro MOS plugin.

You must complete the steps below to access the Streamline Pro Plugin in the AP ENPS interface:

• “Configure the AP ENPS Primary Server”
• “Configure the AP ENPS Client”

 IMPORTANT: 
Before you begin, ensure that Streamline Xchange and Media I/O Workflow Server are both running. 

 VERSION COMPATIBILITY: 
AP ENPS v7.1 + earlier are not supported, see the Release Notes for Streamline Pro compatibility and special 
upgrade path notices.

Configure the AP ENPS Primary Server

To Create a User with Administrator Credentials

1. Login to the ENPS Primary Server with your credentials:

• Username: <Administrator or Root username>
• Password: ********

2. From your Windows Desktop, go to the ENPS System Maintenance shortcut and open it.

3. In the AP System Maintenance dialog, from the left menu go to Settings > Staff.

4. Select Click here to add new row and fill in the required details for a new user with administrative 
permissions, as shown in the example below:

• ID — (AKENNEDY)
• Program — SYSTEM
• Active — Enable
• Supervisor — Enable
• Surname — <last name of user>
• Given name — <first name of user>
• ServerManager — Enable
• Snapfeed — no
• Maintain Tags — no

5. Select ‘Save'
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To Add a New MOS Device

1. Log in to ENPS Primary Server with your admin credentials:

• Username: <Administrator or Root username>
• Password: ********

2. From your Windows Desktop, go to ENPS System Maintenance and open it.
The AP System Maintenance dialog opens.

3. From the Settings menu on the left, select MOS Configuration.

4. Select Click here to add new row, and add the following details:

• Address — Enter MOS ID here.
• Description — Enter MOS ID here.
• IP/Endpoint — Enter the IP address or hostname. If the system is using SSL you must use 
hostname.

• ActiveX — ENPSHTMLHost
• Program — System
• Default settings — URL=http://xx.xx.xx.xxx:xxxx/pro/plugin (Enter the URL provided for your 

Streamline Pro Plugin.)
• MOS Version — Enter the MOS version. In this example, version 2.8.4.
• Local DragDrop — On
• Auto-Create: Enable
• Story Send: Enable
• RO Limit: 0
• Object Type: VIDEO
• Detached ActiveX: ENPSHTMLHost
• Detached Default settings: URL=http://xx.xx.xx.xxx:xxxx/pro/plugin (Enter the pro plugin URL)
• Color: Automatically selected (No need to change anything here)
• Browser type: Chromium

5. Select 'Save'.

 IMPORTANT: 
When you add a new MOS device, there may be a delay before it appears in the AP ENPS Client - MOS devices 
list. It is always recommended that you close the AP Client and then re-open it to apply the changes.

 TIP:
If the MOS device does not show up after a suitable waiting period, you can do the following to trigger a reset:

a. On the ENPS primary server in the Windows search field, type CMD to open the Command Prompt 
application, and select Run as an administrator.

b. Run “iisreset.exe”.

c. Close and re-open the AP ENPS Client on your computer system, and verify that the Streamline Pro MOS 
Plugin now appears under the MOS Device List.

Configure the AP ENPS Client

To Verify that the MOS Device is Accessible

After creating the user account on the AP ENPS Primary server, you can download and install the AP ENPS 
Client.
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1. To download and install the AP ENPS Client:

a. Open a browser, and go to the client URL, where the x is the port number, and the # is the ENPS version:   
\\xx.xx.xx.xx\enps\v#\

b. Download and install Setup.exe.

2. After installing, double-click on the AP ENPS Client to open it. 
The user will be logged in automatically

3. Double-click to launch the AP ENPS client.
The AP ENPS dialog opens.

4. Close the blue Alerts notification bar at the top.

5.  From the bottom menu, right-click the  Devices button and select the MOS device from the drop-down 
menu.
The Streamline Pro plugin window opens in its’ own tab.
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Third Party Non-Linear Editors (NLE)
You can view the list of Non-Linear Editors (NLE) that the Streamline Pro Plugin supports below.

• “EDIUS X Workgroup Setup”

The EDIUS X Workgroup video editor supports the Streamline Pro NLE Plugin. An administrator must run through 
the steps below to add a new NLE device to the EDIUS X Pro video editor, and then configure the client workspace. 
This will allow users to access the Streamline Pro NLE plugin from within the EDIUS X Pro user interface.

 IMPORTANT: 
Before you begin, ensure that Streamline Xchange and Workflow Server are both running. 

 PREREQUISITES: 
You must install a compatible version of EDIUS WORKGROUP before configuring the Streamline Pro Plugin. 
Please refer to the resource below for more information on installation.

• Grass Valley Documentation Library — It is recommended that you refer to the Grass Valley product 
documentation provided for EDIUS Workgroup v10.34. See the Installation Guide, “Chapter 5”:
https://wwwapps.grassvalley.com/manuals/edius_workgroup_10_manual_en/chapter5/chapter_5_l1_5.h
tml#gsc.tab=0

EDIUS X Workgroup Setup
This procedure was written for EDIUS WORKGROUP v10.34. Please refer to Release Notes for the latest version 
compatibility.

To Configure the EDIUS X Workgroup Application

1. Unzip the provided build file, and confirm that you have the following three files:

• StreamlineProPlugin.exe
• StreamlineProConfig.txt
• StreamlineProMenuItem.tpi
• StreamlineProExporter.tpi

2. Move each of the files to the directory location listed below:

• StreamlineProPlugin.exe — C:\Program Files\Streamline Pro\Edius\
• StreamlineProConfig.txt — C:\Program Files\Streamline Pro\Edius\
• StreamlineProMenuItem.tpi — C:\Program Files\Grass Valley\EDIUS X\PlugIn\
• StreamlineProExporter.tpi — C:\Program Files\Grass Valley\EDIUS X\PlugIn\

3. To configure your Streamline Pro Plugin settings, open the streamlineProConfig.txt file, and locate the line 
that says ‘[StreamlineProURL]’. Create a new line immediately under it with the desired Streamline Pro 
host. For example, https://srvottawa01:8443. where the suffix is the Local Area Network port number.

4. Add or update a new line for ‘[ExportPresets]’ and add a line underneath for the default presets you wish 
to use. The presets should follow the syntax below:
‘[ExportPresets]’
{ "<Preset 1 Name>":{"preset":"<preset information>", 
"extension":"<expected_extension>"} }

See the following example:
[StreamlineProUrl]

https://srvottawa01:8443

[ExportPresets]

https://wwwapps.grassvalley.com/manuals/edius_workgroup_10_manual_en/chapter5/chapter_5_l1_5.html#gsc.tab=0
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{"H.264":{"preset":"H.264/AVC MP4 1920x1080 29.97p 
8bit","extension":"mp4"},"XDCAM":{"preset":"MPEG2 1920x1080 50Mbps 
CBR","extension":"mxf"}}

5. To save the file, go to File and select Save.

To Verify that the Streamline Pro Plugin is Accessible

6. Launch the EDIUS application, and go to Tools > Streamline Pro plugin to verify that the plugin appears 
successfully.
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